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Important Instructions for Candidates

()] Please do not open the question booklet until you are told to do so. :

(2)  During examination, if a candidate is found having any literature guide, guide, piece of paper,
handwritten or printed paper, mobile phone, calculator, spy camera, headphone or any other equipments
then the candidate will be considered as disqualified.

3) During the examination if candidates are found conversing with each other, making noise or not
following supervisor’s instructions then they will be considered as disqualified.

(4)  Afterreceiving question paper please write your seat number in OMR SHEET at the correct given place.

(5)  Please do not write your seat number at any other place than the allotted one in the OMR SHEET and

if any sign of your identity or recognition is found then you will be considered totally disqualified for
the examination. |

(6)  Signatures of both the supervisor and the candidate in the certificate of OMR SHEET are compulsory
without which OMR SHEET will not be evaluated, so it is compulsory for the candidate to get
signature of the supervisor.

(7)  Candidates can use blue/black ball pen. They cannot use pens or pencils of any other colour and also
. whitener.

(8)  No marks should be made on any of the options in the question paper.

(9)  There are total 200 questions in this question paper. There is only one answer to each question from
the options A, B, C and D. Four options are given for each question’ All the questions are compulsory.

Example: What is the capital of Gujarat?

(A) Ahmedabad (B) Gandhinagar (C) Vadnagar (D) Patan
Here, if option (B) Gandhinagar is correct then option (B) in the OMR SHEET will have to be darkened
with pen. @@ O ©

(10) ~ One(1) mark is allotted to each correct answer. For each wrong answer 0.25 marks will be deducted. If

a candidate does not want to answer any question then he/she will have to select option E. Negative
marking will not be applicable for option E.

(11)  Cross marked answers, answers given on more than one option and answers re-marked after use of
blade, eraser or whitener will be given Negative 0.25 marks.

(12)  Please hand over the OMR SHEET to the block supervisor after completion of examination before

leaving the classroom. Any candidate failing to do so will be considered as disqualified for the
examination,

(13) Maximum time allotted for the examination is 180 minutes.
(14)  Most appropriate option will be considered as answer of the question.

COMPUTER (A) (1/32)



(1) ~ Howmany Indian languages have been declared endangered by UNESCO

(A) 195 (B) 196 (C) 189 (D) 197
(2)  The National Education Policy (NEP) 2020, integrates __*__ toroot education in ancient knowledge
of India and its contribution in modem India. '
(A) Knowledgeable India (B) Indian Knowledge System
(C) Modem India - (D) Ancient India

?3) The full form of PARAKH is

(A) Private Assessment, Report and Analysis of Knowlcdge for Holistic

B) Perfoxmanc.e Assessment, Review and Analysis of Knowledge for Holistic development
(C) Performance Assistant, Review and Analysis of knowledge for Holistic development
(D) Personal Assistant, Review and Analysis of Knowledge for Holistic development.

(4)  Ascientistof Indian origin who made gr.oux‘lldbreakihg contribution in the study of DNA was____.
(A) Radha Krushnan - | (B) Amartya Sen
(C)Hargovind Khurana " (D)Dr.A.P.J. Abdul Kalam

(5)  The Three Tier Panchayati Raj System was recommendedby .
(A) Mactapl Committee | (B) British Committee

(C) Sevak Committee a o (D) Balwantrai Mehta Committee

©) Commonwealth Games were previously known as
(A) European Games (B) Euro —Asian Games
(C) Common Games - (D) British Empire Games

(7) Who appoints CAG?

(A) Prime Minister v (B) President
(C) Vice-President L (D) Chief — Minister
(8)  The battle between Porus and Sikander was fought on the bank of river. .
" (A) Chenab (B)Ravi

(C) Satluj (D) Jhelum
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(9 “Whoamong the f; ollowing reigned during the Anno Domini period?”
(M) Chandragupt Maurya (B) King Ashok
(C) Khilji Dynasty and Tughlaq Dynasty (D) Bindusara
a0 _ is the most renowned form of dance of Maharashtra.
(A) Ghumar (B) Kalbeliya
(C) Kachhighodi (D) Laavani
(11). was invented by Michacl Faraday?
(A) Penicillin
(B) Periodic Table
(C) Precious Metal - Radium
(D) Conversion of Kinetic Energy into Electric energy
(12) ___ amongthe following was Written by Manubhai Pancholi (Darshak)
(A) Upanas -  (B)Socrates
(C)Anunay . (D) Hayaati
(13) AnupKumaris ‘a renowned ____player. .
" (A) Kho—Kho _ (B) Kabaddi
(C) Cricket | " (D)Football
(14) __ was Suggested by Swami Vivekanand to Promote nationalism in India.
(A) Pride of the nation ' | .
(B) Public awarenegs and uplifiment of the poér
(C) Inclusive Vision
(D) Cultural Pride
(15) ____ isnotarenewable energy resource.
(A) Forest X | g | K ®) Wind
(C) Natural Gas (D) Sunlight -
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% i “ :
6 — vas considered as the “Soul of Indian constitution™ by Dr. B. R. Ambedkar.
(A) Right to Education

(B) Cultural and Educational Rj ght
(C) Right to go against exploitation

(D) Right to the Constitutjonal Remedies

a7 Panchayati Raj Institutions came to exist on in Gujarat.
(A) st May, 1960 | (B) 20th April, 1993
(C) 15th August, 1947 (D) 1stApril, 1963
(18) ____isnotfounded by the Government to implement the recommendations of Mudaliar

Commission 1953,
(A) Rural Higher Education Committee

(B) University Grants Commission

(C)All India Education Council
(D) All India Council of Sports

(19) Astronaut Sunita Williams has an ancestral link with____.

(A)Kamal, Haryana | (B) Vadodara, Gujarat

(C) Mahesana, Gujarat: | (D) Kurukskhetra, Haryana
(20) hosted the Kabaddi World Cup 2025.

(A) India ' (B) England

(C) South Korea (D) Malaysia

(21) Open and Distance Learning (ODL) is included in education.
(A) Formal - (B) Informal
(C) Non-formal (D) None of the above

(22) “Ineverteach my pupils; 1 only attempt to provide the conditions in which they can learn™

who quoted it?
(A)Maharshi Arvind (B) Albert Einstein
(C) Pestology (D) Eric Crome
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(23)

(24)

(25)

(26) |

(27)

(28)

(29)

. . — - ~ - T —
SRS . P e ey . \‘rk*W e

the social needs ang id
lng lt to Qa
“A person must use the development of his individuality by align

This is — _aimof cducation,
(A) an Individual (B)a Social
(C)aPeculiar (D)a govereign

the learner the gog;
the teacher the le ia]
described education as a tri-polar process con51stmg of the

environment or syllabus as a third pole”.

() John Dewey | “(B) John Adams

(C) Herbert Spencer . (D) Benjamin S. Bloom

Idealism is also known as

—_—

(A) Idealism , (B) Realism

(C) Naturalism } : , (D) Pragmatism
John Dewey, Kllpatnck and Mahatma Gandh1 advocated

(A) Existentialism (B) Naturalism
(O)ldealism ‘ "~ (D)Progmatism

Social and National Integratlon can be attained through__

(A) Joint Family - i (B) Requirement of Food

© Democrady | .(D) Population growth

What kind of education enables human to utlhze free time more _]oyful and productlve activities?
A) Non-formal Education

(B) Continuing Education

(C) Life-long Education

(D) Education through conespoﬁdence

The cultural‘objective of education emphasizes on

. (A) to enrich a person with knowledge

(B) to inculcate ideals and moralsin life
(C) to Transfer Knowledge, Art, Literature, Music from generation to generaﬁon,

(D) to enable a person to earn livelihood
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(30)

@31

(32)

(33)

64

(39

(36)

«Human bears th . "
H . ¢ competency of adapting to the situation and adapting one’s needs to the
situation”____ form of pragmatism supports it.

(A) Nominalistic Pragmatism : (B) Experimental Pragmatism
(C) Biological Pragmatism (D) Humanistic Pragmatism
Aperson with1Q score 100, is placed in category.

(A) Average Intelligence (B) High Intelligence

(C) Lower Intelligence (D) Superior Intelligence

___type of Psychological conflict do Students Face when they neither want to stay at home
nor go toschool? :

(A) Approach —Avoidance . (B) Approach — Approach
(C) Avoidance — Avoidance (D) Dual Approach Avoidance

A Psychologist who believed that “Motivation is cyclic”
(A)Lipid ' | (B) C.T. Morgan
(C) Lewin - (D) Emilicuma -

Which test is used to detect mental retardation among children?

(A) Achievement Test (B) Reading Test
(C) Through Genefal Observation (D) Intelligence Test
“The full form of GATBis__ - . '

(A) Great Attitude Test Box.

(B) Global Attitude Test Book
(C) Global Aptitude Test Book -
(D) General Aptitude Test Battery

____isplaced the first among eight stages of Robert Gagne’s approach.
(A) Stimulus — Respohse Approach

(B) Verbal — Association Approach

(C) Problem — Solving Approach

(D) Chaining Approach
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(37)  “Tral and Error Principle” of Thorndike is known as_— ’

(A) Stimulus — Response Approach
(B) Theory of operant conditioning
(C) Cognitive Leaming Theory

(D) Principle of motivation is_
Hierarchy of needsis

. w’s
(38)  After fulfilling basic Physiological need, the next level in Maslo

(A) Love and Belongingness
(B) Esteem Needs

(C) Self—Actualization needs
(D) Safety Needs

"~ (39) Themeasurement of intelligence was first successfully muoduCQd by—
(B) Binetand Simon

(A) Garrett and Menttest

(C) Crow and Crow (D) Thurston and Speareman
(40)  The learning graph remains extended and horizontal during___ temporary stage-

(A) Learning ' - (B) Matirity

(C) Plateau | ‘ : ‘ (D) End

(41) To counsel a student towards the most suitable field of leanﬁng and future profession, educator
usually rely on test. '
(A) Intelli gence Test . (B) Personality Measurement Test

(C) Aptitude Test (D) Diagnostic Test

(42) Toenable astudent to develop their creativity fully and complétely, maximum importance should

be given to
(A) Process _ ‘ (B) Idea
(C) Excellence ‘ | (D) Creativity

(43)  While framing the teaching method in curriculum development, state of students require

prior consideration.
(A) Mental ' (B) Physical
(C) Emotional (D) Holistic
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(44) ._____isPre-requisite in order to promote concentration in Students.
(A) Proficiency of Teacher
(B) Selection of proper method, congruent to the unit
(C)Agelevel
(D) Mental level

(45)  Anyaction that is derived from internal motivation and different from temptation is called .

(A) Improper (B) Motivation
(O) Eligibility T (D) Distress
(46) Classroom behaviour generally observes total types of interactions.
(A) Five ‘ (B) Two
(C) Three ' ' (D) One
(47) ~Bakum developed an evaluation process to measure development of student.
(A) Physical P ~ (B) Mental
(O)Holistic (D) Social
(48) __ hasreleased an educétion from the bandage of Time, Collectién and number.
(A) Internet S , (B) Technology
(C) Website : (D) Open University
(49) Theresearch that scientifically studies the daily problems of the school is called, research.
(A) Pragmatic (B) Action '
(C) Conditioning . : (D) Visiting
(5 0) To find out the mid-point of the given group, is calculated
(A) Median ' (B) Mode
(C) Mean o (D) Any of the above
€2 is also known as Skinnerian Instruction.
(A) Branchial Instruction : (B) Linear Instruction
(C) Mathematical Instruction | (D) All of the above
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(52)

(549

(55)

(56)

(57)

~ (A) PR=100-100

Ten ain EHE
, : 0g cOmpI15€
Ned Flanders' Interaction analysis categornes comp
(1) Teacher's Talk
(i) Pupil’s Talk
(1)) Silence
Which of the following shows the correct order? - 4 (i) 2
! 1
(A (@) 7 (i) 1 (i) 2 (B) U (l.) iy ]
o) (720

(©) () 6 (i) 3 iii) 1
is a correct formula for calculating Percentile Ratc-

R —50)
N

(100R —50)

(B) PR=100"—

_1nq_ (SOR —100)
(C) PR=100———

___ (100R —50)
(D) PR=1———

_is acorreét mean of 6, 9, 10, 12, 16, 17.
(A)10 ’ B 11 .

© 17 (D) 12

“Teacher uses the change in géstures, modulation of voice and hands’ movement so that students

focused” — This is mainly appliedin____skill.

(A) Introductory B) I]lushation
(C) Learning aids Experiment Skill (D) Stimulus change
will replace the (?)
3000, 1500, 500, 125, (?) |
(A) 100 (B)s0 © (©)25 ‘ (D) 20

‘A’is the sister of ‘B’. ‘C’ is the mother of ‘B’ ‘D’ is the father of ‘C’. Then D ié the of.
(A) Maternal Uncle (Mama) | (B) Father ‘
(C) Maternal Uncle (Maasa) (D) Maternal Grandfather
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(58) ___ among the following cannot be framed by using the letter of word
“INDEPENDENCE”
(A)NICE | (B) PINE
(C) PENDING (D) INDEED

(59) Kavyabegins to walk to the south from point A. She turns left after walking 30 metres. Then she
walks 40 metres straight and reaches the point ‘B’. Now find the distance between ‘A’ and ‘B’.
(A) 50 metres - (B) 35 metres
(C) 70 metres (D) 120 metres

(60) IfB=2, BAG =10 then find the value of BOX.
(A) 11 ' " (B)12
(C) 41 (D) 42

(61)  Find the correct odd one from the following.
(A)DEQJ Sk : / (B) MNPS
(O PQTX | . D)TUWZ

(62) Fivefriendsare sitting in a line, A is sitting right to B, but not sitting the first. C is sitting left to D.
If Bis sitting right to E then who is exactly in the middle? ‘

M)A - (B)B Y. (C)D (D)E

(63) Figureisgiven. ;among the option correctly replaces (?).

T

11 1

(A) | ® " | ©) . (D)
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St B

i . | | |
\ “ (64) 34,18, 10, 6, 4. } i
| (A)0 (B) 1 S
(65)  IfDOG is coded as ‘4157 Then LION willbe___— :

(A) 1271514 (13)1291514

i (C) 1291317 (D) 1181514

66 ' ine lof, B Stands 36t from theright
(66)  There are tota] 65 students in a line. A stands 36th from the

— Students must be standing between both Aand B

(A)9 (B) 13

©) 15 D) 11

{ (67) will replace the €))

®
©®OG
(A)91 | "~ (B)610
(C)691 : (D) 587

(68) Thermometer: Témperature :: Earthquake :
(A) Scale (B) Seismograph
(C) Anemometer : . (D) Odometer

(69)  The angle formed by the minute and hour hands at 4:00 pmis

(A) 120° | " (B)100°
| C)80° (D) 60°
(70) among the following will stay first if arranged in alphabetical order.
(A)Overbid . (B) Outstanding
(C)Oval (D) Outstep
l
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71)

YL ALSHAHT YA GUUlaL ucdl {1 ?
(A) A WA 8l 334 3 AR vjor qdAd sl (B) 2064181 8 3\ oe1gR Al |

(C) A MRS 2s314dl A 1T A, (D) 2 0121 U2 g g2z,
(72) 54 sy SRR AL ?

(A) d Q3 evuy 9 ? (B) A 2l 5.

(C) MR Al AXAY B, (D) HR 2RAA ARG .
(73) AR Bl AU Asi eulad Rseu s ?

A | | B

() Al A (i) Ll ged

() 3y A A Al (if) RAolus 0. 4.

(c) @v{l @u(lA ais) (iii) Scaef

(d) ainat 2a A (iv) eiclsEd

(A) (@)1, (d) i, (b) iii, (c) iv | B) (b) i, (9 i, (d) iii, (@) iv

(©) (©)i, (b) ii, (d) iii, (a) iv : D) @1, (¢) ii, (d) iii, (b) iv
(74)  S4LBISIHIAL AGEL As USIRAL % AHRA AR D ?

(A) Al WsAdR i (B) ©rigdld, s143N

(C) seuadl, sllyd - (D) sat_taut{l , %I
(75) L 2106 WAL 2 Fel) 212 v, 53] BLeel O

| (A) Y3Rs | - (B)wds (C)uma (D) Uded
(76) Rl Al uie 5. | |
(A) Ry : (B) 11yl

(C) €l3ycL : (D) [Buya
(77) A, dl, g, a @913 HAdl 56 QeI 2w & ?

(A) Auel- (B) 2AUELA

(C)doiy | (D) 5381
(78)  lciell At 3 [N JL 5L Ut Sl e SUL USR], dleL sdau wa & ?

(A) dlelds (B) [QaReucs

(C) arl-icis - (D) SUlcHs
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(79)

(80)

(81)

(82)

(83)

(84)

(85)

r—— |

d‘tcﬂui QeLYEL, 53&3'@(1 qon s s w87

(A) HA(] gr06) (B) 44 =

(O) AU g0 (D) g™ .
Ay W uRaiag @ ve . | |

(A) 22g B)*13

(©) 5\33. (D) 1{@@

- ' ; =27
TR s @ seyay g o€+l el easatdl o fean eyl

(A) WARs, 2uallafe, Rrav@Qu, st

(B) wdliRs, ullale, B, gy

(©) WRAs, g, D(QuL, Yy

(D) WA, wuluale, Breodln, yapu

TRl 54 woe, vy yafuqual s <l ? _

Asw . \ e (B) A

(C) AuR - | (D) &2

UYLEU Rt 20 NA-uatiel] cupsaeell eRem) Y6 s Wi 5.
(A) 3 20%F As Uy 247, A s se sadl AS.

(B) { 2% s ouy A As g viraci qui,

(C) H 2% A5 2 21 s Yng vyt R,

(D) { 2% s 2 21 6 uadl A, -

(A qusui sy A1 59 uoendloLvld ® ? “&Q U a&wauﬂs BLASLR ).
(A)dQl

(B) A&eydlyds

(C) 2uas12

(D) 21l

Auirstd sdl qw.& ALsY-L vid ¥ 922 5 [Emct vl buél Wl agd e—lq R dA Gy
sUL RigA-l GualoL iy 9 ?

(A) dulig- () , . (B)ISL‘sI{E. [ €4y (A)
(C) @y () | (D) e (*)
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(NO)

87

(88)

(89)

(90)

1)

COMPUTER (A)

Pair the wonds with their antonyms,

Wonds Antonyms
() lazy (1) diligent
(b active (i) Blunt
(¢) sharp (iii) inent
(d) fertile (iv) barren

(A (©) 1, (d) ii, (a) i, () iv
() (©) 11, (d) i, (b) iii, () iv
Which word has no suflix,
(A) Health

(©) Embrace

Find out the odd pair.

(A) proud - pride

(C) grieve - grief

(3) () i, (e) i, (b) 1, () iv
(D) () i, (dy iii, (e) 1i, (b) iv

(B) Library
(D) Marringe

(B) bond - bind

(D) lose - loss

Arrange these sentences in proper order to describe an accident-scene,
(1) Passengers were told to be ready to quit the ship.

(ii) Everyone knew there was fire on board.

(i1i) Smoke oozed up between the planks.

(iv) Flames broke out here and there.

(v) Most people bore the shock bravely.

(A)iii, ii, v, i, i (B) 1, ii, iv, iii, v

(C) v, iii, i, v, i (D) iii, iv, ii, i, v

Select the sentence with almost similar meaning to the sentence “At the moment the duck looked

exhausted.”

(A) The duck looked dreadful

(C) The duck looked very tired. (D) The duck seemed unhappy.
Put proper preposition in the blank. He was looking ................ his lost keys.
(A)at : (B) for
(C) after (D) into

(15/32)

(B) The duck was looking for a place to hide
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(92)

(V1)

(94)

(95)

(96)

o7

(98)

(99)

(100)

S ———

ith
blank W
.................. he finds o Jjob, his family will starve. Fill in the (D) However

(A1 (13) Unless (€A

The harder yYouwork, the ..o, result you will get.

(A) pood (B) best

(C) better (D) lower

Seleet the similar word for Inventory.

(A) Summary (B) schedule

(C) Index (D) Questionnair® mplete the
Allthe crows are black, We .........o.... {ind a white crow, putp Lopet BIERES e
(A) frequently (B) usually

(C) rarely (D) always

Which expression best conveys the idea ?

(A) During the curfew, the streets wearing desolate look.

(B) During the curfew, the streets wore a desolate look.

(C) During the curfew, the streets have had worn desolate looks

(D) During the curfew, the streets has been wearing desolation looks

What is the correct noun form of the verb ‘compel’ ?

(A) Compelation (B) Compulsion

(C) Compulsory (D) Compellment

Fill in }he blank with the correct preposition : “The committee is totally opposed ................. ther
proposal.” _

(A) for | ~ (B)against

(Oto ' (D) with

Fill in the blanks with appropriate articles : “He is .................. heir to the throne and .........

honest man.”
(Aaa (B)an, a ©anan  (D)the,a
Identify the correct verb according to subject-verb Agreement : “Nelther the principal nor the tea!

present at the meeting yesterday » o

----------------

(A) was | (B) were (C) are , (D)is
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(101)

(102)

(103)

(104)

(105)

(106)

(107)

A computer that can handle multiple elements such as text, graphics, audio, video, and animation is
known as which of the following?

(A) Digital computer (B) Logic computer
(C) Supercomputer (D) Multimedia computer
Which of the following is NOT one of the recording options listed in the ‘Record as\ drop-down list of

the Ubuntu Sound Recorder application?

(A) CD quality, Lossless (B)CD qoality, Loesy
(C) Voice (D) High Definition
What is the informal term used to describe the combination of education with entertainment, specifically
through multimedia application?

V (A) Infotaimrlent- (B Edutainment (C) Edumedia (D) Technotainment
During which stage of multimedia productlon does the developer find out about the target audience,
their skills, needs, and qualifications?

~ (A)Scripting - (B) 'Collection.of elements
(C) Research and Arral)rsis (D) Storyboarding
Be51des Linux and Wmdows on which other operatmg systems Synﬁ g Studio available accordurg to
the GSEB Std-11 textbook?

(A) Android . (B)MacOS X ©ios (D) ChromeOS
What was the specific version number of the very first rel_ease of Synfig Studio?

(A)0.63.05 - (B) 0.50.01 © ,0.61.05 ; (D)o. 1.0.01
While using the BLine tool to create objects what specific mouse actlon is required to stop the
drawing of the object?

(A) Double-click the canvas (B) Press thé Esc key
(C)Right click on the.last point . | (D) Click the ﬁrst point created
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’1

(108)

(109)

(110)

(111)

(112)

(113)

(114)

(115)

e T rties dlalog boxr)
1, vas prOPC

: <. 1ab of the Can

What is the default “End tjme setting in the Time tab ©

(A)2s (B) 3s (C) 58 layed after the rendering
' » displa _
sfully” disp

Where is the confirmation message “file rendered SUCCES

is complete?

anel
(A) In the middle of the Canvas (B)In the Keyerm® pel
(C) On the window status bar at the bottom (D) Inthe s uld be di;playéd using ,
Tolistall available shells in a Ubuntu Linux system, which Spc‘:iﬁ c file sho
command? o A
(A) /etc/bash (B) /bin/shells (C)ete/shells

: include the standarq ]
W1 . stchi equlred to1nc :
When using the command line calculator (be), which switch1ST

library for advanced functions?

D)-—math
(A)-m (B)—s | (€)1 D) ) |
What is the standard charécter limit foré file name or directory name in most modern Linux sys
(A) 8 characters | (B) 128 characters
(C) 255 characters , . (D) 1024 characters

in the user’sh
Which option should be used with the Is command to list the files currently re&dmg

dlrectory, regardless of the current working path?
| i Is-h
(A)ls~ (B)ls/ : ©)ls.. : (D)

When assigning file permissions numerically, what does the octal value ‘6’ represent for a specific

category? |
(A) Read and Execute | *(B)Read and Write
(C) Write and Execute : (D) Read, Write and Execute

In a long listing (Is -1), which character in the first column indicates that the object is a “process’

(A)— (B ©p . (D)s

18/32
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(116)

(117)

(118)

(119)

(120)

(121)

1¢ find cor
Intl nmand, which option allows an administrator to specifically search for files that have a

of exact
size actly zero bytes ; and delete them simultancously?

(A) find -empty -rm (B) find -size 0 -rm

(C)_ find -size 0 -delete (D) find -type f -clear

If youexecute the comm

and cat report.txt notes.txt > final.txt, that will be the internal structure of
final.txt? :

(A) The contents of notes. 1t followed by report.txt.

(B) The contents of report,txt followed by notes. txt.

(C) Only the contcn‘ts of report.txt; notes. txt is ignored.

(D) Both files are merged alphabetically by their internal text.

You wish to copy a file named report into an existing folder named archives, but you want the copy to
be renamed old_report. Which command should you use 6.5?

(A) cpreport archives (B) cpreport archives/old_report
O)mv repbrt archives/old_re;brt (D) cp-rreport old_report

Consider the command cp chap01 progs/unit1. According to the documentation, what is a necessary
condition for unit1 to become a file containing the contents of chap01?

(A)Adirectory named unitl must already exist inside the progs directory.v

(B) No directory named unit1 should exist in the progs difectory.

(C) The -r option must be included to allow 'renar‘ning during a copy.

(D) The progs directory must be empty before the command is run.

Which of the following is defined as a collection of related data items stored in an organized manner?
(A) Attribute (B)Entity = - '(C) Database (D) Spreadsheet

For which alphanumerlc data type does the number of bytes allocated depend spec1ﬁcally on the
actual number of characters entered by the user?

(A) Text (fix) [CHAR] ~ (B) Text [VarChar]

(C) Memo [LongVarChar] (D) Binary (fix) [Binary]
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Which of the cight steps in the Query Wizard is the only that i €O
(A) Sorting order (B) Search conditions
(C) Aliases (D) Field selection
Whatis the primary purpose of the “Aliases” step in the Query wizard?
(A) To change the data type of the field
(B) To group records together
(C) Todisplay field names in a human-readable form .
(D) To hide fields from the final output
In a Parameter Query, what symbol must immediately precede the paramcter name in the Crite;
cell to prompt the user for input at runtime?
(A) Semicolon (;) (B) Questionmark (?)  (C) Asterisk (*) (D) Colon ()
Which of the following is an example of text formatting?

| (A) Font size - ~ (B)Animation - (C)Video (D) Recording
Which of the following is an image ﬂlé format? |
(A).mp3 ®)ai  (C).png - (D).wav
What is the main working area for drawing in Synfig Studio callcd".7 |
(A) Toolbox (B) Canvas .(C) Panel (D) Palette
Which path is uséd to open Synfig? V |
(A) Applications -> Graphjcs->Synﬁg Studio
(B) Applications -> Office -> Writer
© Applicationé -> Internet -> Browser
(Ij) Applications -> Programming -> Python
Which component is useful for controlling time in Synfig animation?
(A) Toolbar : (B) Timetrack . (C)Palette (D) Canvas
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' (13 1sqlcmllcd In Linux?

A) Editor e o
( | (B) l‘cm\mul (C) Compiler (D) Browser
1) Which of the followingisnotmype of Shell?

Shell?

(B) KomShel
(132) Whatis the full for, of DBMS?

(A) Boume She|)
(C) C Shell (D) Java Shell

(A) Data Backup Managemem System
(B) Digital Base Managemen System
(C) Data Binary Management System

(D) Databasc Management System
(133) WhatisaField in table?

(A) Row (B) Column (C) Database (D) Query
(134) Whatis the purpose of 3 Foreign Key?

(A) To delete tables '

(B) To edit data

(C)To searcﬁ for records

(D) Tocreate a relationship between two tables
(135) Whatis the main purpose of Referential Integrity?

(A) To arrange data |

(B) To print data

(C) To maintain data accuracy and cbnsistency '

(D) To hide data

(136) Which is the easiest method to create a query?

(A) SQL View (B) Design View (C) Query Wizard (D) Table View
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What is the first stepin Form W

izard?
(A) Select Layout ") Givea Form name
(C) Select Fields ‘ (D) Select Data Mode
What is the main objective of Mobile Computing? ‘ o
(A) To operate only desktop computers (B) To use data and inform Wireg
(C) Only offline computing | (D) Only software development
Which option is used 1o arrange records in a query? N
(A) Sorting (B) Filtering (C)Gr ouping (D) Joining
What s the main use of 3G technology?
(A) Only voice calls
(B) Only SMS

(C) High-speed mobile data and video calling

(D) Only email

In KompoZer’s normal view, what visual indicator is used to show the boundaries of a form oy
canvas? :

(A) A solid black line | (B) Adotted Blue box

(C)Alight gray shaded area | (D) A red dashed bdrder

Which menu path is used if a user wishes to apply a specific background color to a form they
designing?

(A) Insert -> Background Color (B) Tools -> Page Setting

(C) Format -> Page Colors and Background (D) Edit -> Form Properties’

In JavaScript, how are statements grouped together into a “block” for execution?
(A) Within square brackets [ ] 4 (B) Using indentation levels
(C) Inside curly brackets { } (D) Using the <block> tag
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AccOrdmg to the evepy dcscnpnon table
able, wi,

atoccurs when the “blur” event is triggered?
A) The user clicks Ona fory g
e

lnCl’ll

B) Aform elemcnt Such ag
( ch aradig bulton becomes inactive
Anerror ocey 1
© IS durmg the loading ofa document
umen

(D) The page is reloadeq by the user

what is the prim ; |
ary advantage ofkeeping a do cument’s style separate from its information content?
(A) It reduces the Number of; mages on the p
age

@B allows e bmwser toignore CSS errors

(C)Itallows modifying the layout without ehanging the content

(D) It automatically validates the user’s input

While configuring J avaScript Event in KompoZer’s Advance Property Editor, which SpeClﬁc R
must be selected to trigger return validateForm( )?

(A) onclick (B) onsubmit (Cyonload (D) onreset

Accordlng to the JavaScript event definitions, which event is triggered specifically when the * ‘Loadmg
of image is cancelled”?

(A.) abort (B) error © load - (D) mouseout

What are the freely available web51te designs that can be downloaded and customized to create a
- website called?

(A) Blueprints (B) Templates (C) Wireframes o (D) Prototypes

What is the intended function of “alternate text” when inserting an image into a web page?

(A) It changes the resolution of the image

(B) It adds a colorful border around the image.

(C) It displays text in case the image cannot be displayed in the browser

(D) It converts the image into a clickable link
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To ensure an image ills an entire table ce Al
Dimensions tab of the Image Propertics dinlog b‘”‘]

(A) Selecting ‘Actual Size’ with a fixed pixel width
(13) Selecting ‘Constrain’ with a 50% ratio
o 100%0f ¢!
(C) Selecting *Custom Size' and t ,pcu[ymyhu;’ht
(D) Choosing ‘Auto Size” under the Appearance tab )
entioned for the bidder?
In the context of online auctions, what is the primary ¢
(A) Getting the highest possible price fora product
(B) Saving time to get the product of their choice
(C) Creating their own payment gateway
(D) Eliminating s the need foratime lnml
sfully booked on the IRCT

; . {5 SUCCES
What specific inf ormahon is sent to auseroncear allwa}’ ticket 15 SU

website?

(A) A physical copy via registered post

(B) An E-copy of the ticket viamail and SMS on the mobile

(C) A phone call from the station master
é

(D) Only a confirmation number displayed on the screen

Based on the description of E-commerce in India, how has the internet impacted rural areas?

(A) Ithas decreased the variety of goods available.
(B) It has primary benefited high-end designer apparel sales only.

(C) It has changed lifestyle and consumption mindsets.

(D) It has made online buying less attractive due to security.

(24/32)
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ned as a “hidder specifically when they are doing Wh

auctipp

® pidding fora product Placeq by

4
85) For users who have nog yet Cre
‘1

ated a 1gp; . tee - ’ ich stage are
they asked to create one? oBin during the Flipkart checkouit process, at whic g

(A) Immediately upon entering the welsite
@) After selecting the firs item for he cart

(C)After pressin_g the “Place Order» button

(D) Only after the payment i successfully processed |

156) Whichafthe following i NOT Specifically listed as a wireless device used for M-Commerce?

(A) Smartphone (B) Personal Digital Assistant (PDA)

(C) Desktop Personal Compu‘ter (D) Palmtop

(57 When determining a location through triangulation, a mobile device utilizes how many satellites to
create an intersecting point?

(A)Two - ®) Three | () Five

AY

(D) Twenty-four

(158) What is the primary reason provided for why RuPay cards reduce the cost of each transaction clearmO
and settlement compared to Visa or Mastercard?

(A) They use lower-quality plastic
(B) They do not require e PIN
(C) Transaction processing is done domestically within india.

(D) They are only available for government erhployees.

(159) Unlike procedural programming, how does object-oriented programmmg view the core elements of

data and functions?
(A) As two separate entitics (B) Asindependent modules
(C)Asglobal variables (D) Asasingle entity
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In the context of inheritance, which term is used as another nam™

classes?

‘ (D) Composition
() Aggregation (13) Encapsulation (©) Generalization
Which input type is used to create a text box inan HTML form?

(D) password

(A) Radio (B) Checkbox (C) Text
Which input type is used to submit a form? .
(A) Submit (B) Reset (C) Text ®) R
What is the basic syntax of a CSS rule?
(A) selector {property:value;} (B) property {sclector:value;}
(C) selector:value;property (D) value {selector:Pmpeny;}
What is the first important step in the process of creating website?
(A)Publishing ®)Planning (C) Designing (D) Uploading
What is the process of making a website available on the internet called?
(A) Hosting ~ (B)Publishing (C) Browsing (D) Designing
What is meant by ;‘Online Auctions™?
(A) Online education (B) Online bidding process
(C) Online banking D) Online games
What is thé full form of M-commerce?
(A) Mobile Communication " (B)Mobile Commerce _
(C) Modern Commerce , (D) Machine Commerce
Which method is used to provide security in E-commerce and M-commerce?
(A) Encryption B) Combilation (C) Compression (D) Animation
What is the full form of UML? | | |
(A) Universal Machine Language’ ~ (B)Unified Modeling Language
(C) Unique Modeling Language | (D) Universal Module Language
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(179)

Which compileris used to compile a Java program?
(A)Java (B) Javac (C)jvm (D) jdk
Which intcrprete‘r is used to run Java bytecode?
(A)IVM (B)JIDK (C)JRE (b) Editor
What is an object?

(A) Aninstance of a class (B) A type of method

(C) Adata type (D) A program

Which ofthe following is a visibility méc_iiﬁer?

(A) public | B)static . - (C)final (D)class
Which is the correct syntax to declare a 1-D Arr.ay? '

(A int marks; ° (B)intmarks[];" (¢) *array intmarks; (D) *marksint[]; "

The Date class belongs to which package? |

(A)jav(a) io  (B)jav(a)lang (C)jav(a) util (D)jav(a) sql
‘What does a Class represent?

(A) Datafile (B). Blueprint for objects

(C) Compiler | " : ‘ (D) Databage

What is the commonly used name for the main page of a website?

(A)home.html (B)index.html (C) starthtml (D) main.html
Which éomponeqt of a website inclﬁdes images, videos, and audio?

(A) Medié (B) Content (C) Hyperlink | (D) Navigation
What is the main purpose of Data Abstraciion?

(A) Show all data ‘ (B) Show only necessary information

(C)Deletedata - v (D) Stop program
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(180)  What is the main purpose of n constructor?

en yariable

) ' ‘To dele

(A) To create an object 5 i
|nss

(D) To delete clas

(C) To compile a program ",
. . imedia?
" {multme
- b A . rymponents 0
(181)  Which teaching method is most eflective o explain the comj ’
:on methe
(A) Lecture method (B3) pemonstra
R i method
(©) Dictation method (D) Reading R
oduction?

1eimedia pr
: o ' . : o etnoes of multimee
(182) Which teaching method is appropriate to explain the stages of

(B) Dictation method
method

(A) Discussion method
(C) Repetition method D) Translation

) . . . i ﬂl?
(183) What should be the role of a teacher while teaching computcr practic

(A) Only reading content B) Providing guidance

(C) Not allowing students to practice (D) Only dictating notes

. ; .
n while teaching Linux commands?

(184) What should a teacher do to increase student participillio
(A) Deliver a long lecture (B) Give practical exercises
(C) Ask students to write notes only (D) Conduct tests
(185) How should ateacher explain DBMS effectively?
(A) By only reading from the boék ' (B) By explaining with examples
(C) By avoiding questions | (D) By only writing notes
(186) Which teaching approach is best for explaining field properties ina database?
(A) Demonstration + Pfactic'c (B) Lecture only
(C) Reading only : (D) Dictation
(187) Ifateacher wants to explain Query Wizard effectively, which teaching method is most abpropriatc'?

(A) Lecture Method (B) Demonstration Method

©) Discussion Method (D) Story Method
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which method encourapes aefie. _ '
X ages active participation of students while teaching Forms and Reports in
computer studies? —

A) Lecture Method
i 0 (B) Activity-Based Method

() Dictation M
©) cthod (D) Reading Method

If students are asked to collect information about

' ucloud Computing“ and pTCSCnt itin grOUpS’ "‘/hiCh
teaching method is used?

(A) Project method (B) Question-answer method

(C) Lecture method (D) Essay method

Showing animations or videos to explain how GPS works is an exmaple of which teaching method?

(A) Lecture method - (B) Audio-Visual method

(C) Project method (D) Question-answer method '

While teaching KompoZer, what should teacher do?

(A) Explaiﬁ onlytheory . ; Fa (B) Give practical work to students
© Ask students to read the book | (D) Give written notes only

Which teaching method is most suitable for teaching CSS?

(A) Demonstration Method (B) Lecture Method

g (C) Conversation Method . A (D) Discussion Method

“Which teaching aid should be used by a teacher to explain website publishing effectively?
A) Blackbbard (B) Projector and Computer

(C) Map | | (D) Chart

Which educational tool is besf for explaining Online Banking?

(A) Vicieo demonstrationk , B) Chalk only

(C) Chart only (D) Notebook
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(195) Whichactivity is most suitable to explain Mobile Shoppiné to st

(A) Live demonstration of a mobile application
(B) Only lecture

(C) Writing notes

(D) Conducting an exam

(196) What is the most cffective way to explain Class and Object?

(A) Giving real life examples (B) Writing only definitions |

(C) Reading the lesson (D) Avoiding questions
(197) Which method is more sﬁitable for teaching Java data types?

(A) Lecture with exarnﬁlés (B) Conversation method

(C) Learning through games : (D) Project based Jearning

: : S hi 2
(198) Showing code examples while teaching Java programming is an example of which method?

(A) Lectﬁre method ‘ ' B) Demonstration method

(C) Project method | " (D)Assignment method

' (i 99) Giving stﬁdents proéramming exercises to write code isan example of whlch rnethod"
(A) Drill method - B) Prac'tica.l' method

(C) Story method ) (D) Dictation method -

(200) Which approach is most effective for teaching String methods?

(A) Practical hands-on coding (B) Lecture method
(C) Copying notes . ' (D) Giving complex definitions
® 0O
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